
 

Note:  

 The school will reopen on 6th July, 2026. 

 Parents can submit the holiday homework between 2nd July to 4th July 
during school working hours.  

 



 

 

Dear Students, 
 

Kindly follow the given guidelines while completing your Holiday Homework: 

 

 Complete the work neatly and systematically in a separate file/folder as instructed by the subject 

teacher. 

 The work should be creative, innovative, research-based, and connected with real-life applications. 

 Include case studies, surveys, newspaper articles, data collection, self-analysis, or experiential 

learning wherever applicable. 

 Avoid copy-pasting from the internet. Originality and independent thinking will be appreciated. 

 Use diagrams, charts, mind maps, QR codes, presentations, art integration, and digital tools to 

enhance your work. 

 Maintain good handwriting, proper labeling, presentation, and overall organization. 

 Assignments should reflect conceptual understanding, analytical skills, and subject knowledge. 

 Reading newspapers, journals, biographies, educational magazines, and reference books during 

vacations is highly encouraged. 

 Practical learning through observation, interviews, field visits, and family interaction should be 

included wherever possible. 

 Submit the Holiday Homework on time after the vacations. Late submission may affect assessment 

and evaluation. 

 Along with academics, students should also focus on physical fitness, hobbies, relaxation, and quality 

family time for holistic development. 

 Complete your work sincerely and make your vacations productive and meaningful. 

 Revise the PT-2 syllabus regularly during the vacations for better understanding and retention of 

concepts. 

  



Holiday Assignment: "Unwind & Imagine" 
 

Dear Students, 

This vacation, step away from the academic pressure, turn off your screens, 
and let your mind relax. There are no strict rules, no themes, and absolutely no 
pressure to make a "perfect" masterpiece. Your only goal is to create 
something entirely from your imagination that helps you recharge. 
Love and Blessings!! 
 

Guidelines 

 What to Draw: Anything you want. It could be a dream landscape, an 

abstract pattern of shapes, a character, or just a stream-of-consciousness 

doodle. 

 Medium of Choice: Use whatever you have at home—watercolors, acrylics, 

color pencils, oil pastels, sketch pens, or just a simple graphite pencil. 

 The Canvas: You can use a drawing sheet, a page in a sketchbook, a 

canvas, or even upcycle a piece of cardboard. 

Important Reminders 

 Do not be in any hurry to finish your work of art. Give it time and enjoy the 

process of making it. 

 Do not copy or download designs from the internet; let the ideas be 

entirely your own. 

 Do not stress about the final result or worry about making mistakes. 

 Do not treat this as a chore or a rigid academic task—just have fun and 

create at your own pace. 

 

Reflection Note 

 On the back of your artwork, write a short 2-3 sentence note sharing how 

you felt while creating it and what your imagination brought to life. 

 

 



 

 

 

SECTION A - READING SKILLS 
1. Read the passage carefully and answer the following questions. 

Importance of Saving Water 

Water is one of the most precious natural resources on Earth. It is essential for the survival of human 

beings, animals, and plants. We use water for drinking, cooking, cleaning, agriculture, and industries. 

Despite its importance, many people waste water carelessly. They leave taps running, pollute rivers, and 

overuse groundwater resources. 

The increasing population and urban development have increased the demand for water. Many regions of 

the world are facing water shortages due to climate change, irregular rainfall, and excessive use of water. 

Farmers also face difficulties when there is not enough water for irrigation. If this problem continues, 

future generations may suffer greatly. 

Saving water is the responsibility of every individual. Small steps such as turning off taps, repairing leaking 

pipes, using buckets instead of showers, and harvesting rainwater can help conserve water. Schools should 

also educate students about the importance of water conservation. If we save water today, we can secure 

a better future tomorrow. 

i. Water is essential for: 

a) Humans only  b) Animals only  c) Plants only  d) All living beings 

ii. One major reason for water shortage is: 

a) Proper usage  b) Rainwater harvesting c) Climate change d) Clean rivers 

iii. Farmers need water mainly for: 

a) Transport   b) Irrigation   c) Entertainment d) Construction 

iv. One way to save water is: 

a) Leaving taps open      b) Polluting rivers   

c) Repairing leaking pipes     d) Wasting groundwater 

Short Answer Questions 

v. Why is water important? 

vi. How do people waste water? 

vii. Why are many regions facing water shortages? 
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viii. How are farmers affected by water scarcity? 

ix. Mention two ways to save water. 

x. Why should schools spread awareness about water conservation? 

2. Read the passage carefully and answer the following questions.                

      Value of Hard Work 

Hard work is the key to success. No person can achieve great things without dedication, determination, and 

continuous effort. Students who work hard regularly often perform well in academics and other activities. 

Hard work teaches discipline, patience, and responsibility. 

Many successful people faced difficulties in life but achieved their goals through consistent efforts. 

Scientists, athletes, leaders, and writers worked hard to reach great heights. They did not give up when 

they faced failures. Instead, they learned from their mistakes and continued working toward their dreams. 

Nowadays, many students look for shortcuts to success. They depend on unfair means or avoid regular 

practice. Such habits can never lead to long-term success. True success comes only through honesty and 

hard work. Therefore, students should develop the habit of working sincerely and consistently. 

i. Hard work is the key to: 

a) Failure   b) Success   c) Laziness   d) Weakness 

ii. Hard work teaches: 

a) Carelessness  b) Discipline   c) Fear    d) Anger 

iii. Successful people achieved goals through: 

a) Luck only   b) Shortcuts   c) Continuous effort  d) Avoiding work 

iv. True success comes through: 

a) Dishonesty   b) Shortcuts   c) Hard work and honesty d) Luck 

Short Answer Questions 

v. Why is hard work important? 

vi. What qualities does hard work teach? 

vii. How do successful people deal with failures? 

viii. Why are shortcuts harmful? 

ix. What habits should students develop? 

x. How does hard work help students in life? 



SECTION B - GRAMMAR WORKSHEET 

Exercise 1: Tenses  

Fill in the blanks: 

a) She ______ to school every day. 

b) They ______ cricket yesterday evening. 

c) I ______ my homework already. 

d) We ______ dinner right now. 

e) He ______ in Delhi for five years. 

Exercise 2: Identify the Tense 

Identify the tense of the following sentences: 

a) She is singing a song. 

b) They played football yesterday. 

c) I have completed my work. 

d) He will visit Jaipur next week. 

e) We had finished dinner before they arrived. 

Exercise 3: Change the Tense 

Rewrite the sentences as directed: 

a) She writes a letter. (Change into Present Continuous) 

b) They are playing football. (Change into Past Continuous) 

c) He completed his work. (Change into Future Tense) 

d) I will go to Delhi tomorrow. (Change into Past Tense) 

e) We have finished our homework. (Change into Simple Present Tense) 

Exercise 4: Subject-Verb Concord 

Choose the correct verb: 

a) The boys ______ playing in the park. (is/are) 

b) Each student ______ responsible for homework. (is/are) 

c) Neither Ram nor his friends ______ present today. (was/were) 

d) My brother and sister ______ going to school. (is/are) 

e) The news ______ shocking. (is/are) 

 

 

 

 



 

SECTION C - WRITING SKILLS 

3. Formal Letter  

(Roll no 1-15) 

You are interested in a short term course in computer graphics during the holidays. Write a letter to the 

Director, Fortune Graphics Computers, inquiring about their short- term courses and asking for all the 

necessary details. You are Anuj/ Anju of 28A, Uttam Nagar, New Delhi. 

(ROLL NO-16-30) 

Write a letter to the Editor regarding the increasing problem of pollution in your city and suggest solutions. 

SECTION D - LITERATURE 

4. Write the “Life Journey of Nelson Mandela” in your own words. 

5. Explain the poem Summary of “Dust of Snow” in your own words. 

SECTION E - PROJECT WORK 

 Project on Famous Poet – 1. Robert Frost  

Include: Biography Early life Famous poems Writing style  Awards 

               Interesting facts  Your favourite poem by him 

(Add pictures and creative work.) 

Instructions: 

✔ Complete neatly in your notebook. 

✔ Use proper headings. 

✔ Submit after summer vacation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 

 प्रश्न 1. अऩठित गदमयॊश  

ऩमयावयण हभयये जीवन कय आधयय है। शुद्ध वयमु, स्वच्छ जर, ऩेड़-ऩौधे तथय प्रयकृततक सॊसयधन भयनव जीवन को स्वस्थ 

औय सुयक्षऺत फनयत ेहैं। आज के सभम भें फढ़ते प्रदषूण, ऩेड़़ों की कटयई औय औद्मोगीकयण के कययण ऩमयावयण को बययी 
नुकसयन ऩहुॉच यहय है। नददमयॉ प्रदषूषत हो यही हैं, वयमु दषूषत हो यही है तथय ग्रोफर वयर्भिंग जैसी सभस्मयएॉ तेजी से फढ़ 

यही हैं। मदद सभम यहत ेऩमयावयण की यऺय नहीॊ की गई, तो आने वयरी ऩीदढ़म़ों को गॊबीय कदिनयइम़ों कय सयभनय कयनय 
ऩड़गेय।ऩेड़-ऩौधे ऩमयावयण को सॊतुर्रत फनयए यखने भें भहत्वऩूणा बूर्भकय तनबयत ेहैं। व ेहभें ऑक्सीजन प्रदयन कयत ेहैं 
औय वयम ुको शुद्ध फनयत ेहैं। इसर्रए हभें अधधक स ेअधधक ऩेड़ रगयन ेचयदहए तथय जर औय बफजरी कय अनयवश्मक 

उऩमोग नहीॊ कयनय चयदहए। प्रत्मेक व्मक्क्त कय कताव्म है कक वह ऩमयावयण सॊयऺण के प्रतत जयगरूक फने औय दसूय़ों को 
बी इसके र्रए प्रेरयत कयें  I  

1. ऩमयावयण को ककसकय आधयय कहय गमय है? 

2. भयनव जीवन को स्वस्थ औय सुयक्षऺत फनयन ेभें कौन-कौन सहयमक हैं? 

3. आज ऩमयावयण को नुकसयन क्म़ों ऩहुॉच यहय है? 

4. गद्मयॊश भें ककन सभस्मयओॊ कय उल्रेख ककमय गमय है? 

5. सभम यहते ऩमयावयण की यऺय न कयने ऩय क्मय होगय? 

6. ऩेड़-ऩौधे ऩमयावयण के र्रए ककस प्रकयय उऩमोगी हैं? 

7. ऩेड़ हभें क्मय प्रदयन कयत ेहैं? 

8. हभें ककन सॊसयधऩों कय अनयवश्मक उऩमोग नहीॊ कयनय चयदहए? 

9. प्रत्मेक व्मक्क्त कय क्मय कताव्म फतयमय गमय है? 

10. गद्मयॊश के र्रए उऩमुक्त शीषाक र्रखखए। 

प्रश्न 2.ननम्न वयक्मों कय वयच्म फदरकय लरखिए – 

(क) ययभ ऩत्र र्रखतय है। 

(ख) फच्च़ों द्वययय ऩेड़ रगयए गए।  
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(ग) भैं गीत गय यहय हूॉ। 

(घ) महयॉ फैिय नहीॊ जयतय। 

 प्रश्न 3.ननम्न वयक्मों कय यचनय के आधयय ऩय बेद फतयइए – 

(क) भोहन षवद्मयरम जयतय है। 

(ख) भैं फयजयय गमय औय पर रयमय। 

(ग) जो छयत्र भेहनत कयतय है, वही सपर होतय है। 

(घ) मदद वषया होगी तो हभ नहीॊ जयएॉगे। 

 प्रश्न 4. ननम्न वयक्मों को सॊमुक्त वयक्म भें फदलरए – 

(क) यषव ऩढ़तय है। यषव खेरतय है। 

(ख) सीभय फयजयय गई। सीभय पर रयई। 

(ग) फच्च ेहॉसे। फच्च ेतयरी फजयने रगे। 

(घ) भयॉ खयनय फनयती है। भयॉ हभें खखरयती है। 

प्रश्न 5. ननम्न ववषमों ऩय 80–100 शब्दों भें अनुच्छेद लरखिए – 

(क) ऩमयावयण सॊयऺण (अनुक्रभयॊक 1 से 13 तक) 

(ख) सभम कय भहत्व 

(ग) स्वच्छ बययत अर्बमयन (अनुक्रभयॊक 14 से 26 तक) 

(घ) षवद्मयथी जीवन 

प्रश्न 6 औऩचयरयक ऩत्र लरखिए – 

(क) ऩुस्तकयरम भें नई ऩुस्तकें  भॉगवयने हेत ुऩत्र।। (अनुक्रभयॊक 1 से 13 तक) 

(ख) षवद्मयरम भें स्वच्छतय की सभस्मय के सॊफॊध भें ऩत्र। (अनुक्रभयॊक 14 स े26 तक ) 

 



 प्रश्न 6. ई-भेर रेिन – 

(क) अऩने र्भत्र को ऩयीऺय ऩरयणयभ की जयनकययी देते हुए ई-भेर र्रखखए। 

(ख) षवद्मयरम भें छुट्टी के र्रए ई-भेर र्रखखए। 

प्रश्न 7. ऩयि रिनवी अॊदयज वह नेतयजी कय चश्भय कय सयय अऩने शब्दों भें लरखिए। 

प्रश्न 8. क्रिमयत्भक कयमय - ऩोर्यपोलरमो तैमयय कीजजए।  

 सूयदयस (अनुक्रभयॊक 1 से 13 तक) 

 तुरसीदयस(अनुक्रभयॊक 14 से 26 तक) 

प्रस्तयवनय, बूलभकय, यचनयएॉ औय सयठहत्म के ऺेत्र भें स्थयन 

  



 

 
 
 
 

Chapter 1: Real Numbers  

1. Find the HCF of 96 and 404 using Euclid’s Division Algorithm.  

2. Check whether 6ⁿ can end with the digit 0 for any natural number n.  

3. Express 0.375 as a rational number in simplest form.  

4. Find the LCM and HCF of 26 and 91 and verify the relation: Product = LCM × HCF.  

5. Prove that √5 is irrational.  

Chapter 2: Polynomials  

6. Find the zeroes of the polynomial x² – 5x + 6.  

7. Verify the relationship between zeroes and coefficients of the polynomial x² – 7x + 10.  

8. Find a quadratic polynomial whose zeroes are 3 and –2.  

9. Divide x³ – 3x² – 4x + 12 by x – 3.  

10. Check whether x + 2 is a factor of x³ + 8.  

Chapter 3: Pair of Linear Equations in Two Variables  

11. Solve by substitution method: x + y = 10 and x – y = 4.  

12. Solve graphically: 2x + y = 7 and x – y = 2.  

13. Solve using elimination method: 3x + 2y = 12 and 2x – y = 3.  

14. Find the value of k for which the equations 2x + 3y = 5 and 4x + 6y = k have infinitely many 

solutions.  

 

15. The sum of two numbers is 27 and their difference is 5. Form equations and solve.  

Chapter 4: Quadratic Equations  

16. Solve: x² – 9 = 0.  

17. Solve by factorisation: x² – 5x + 6 = 0.  

18. Find the roots of 2x² – 7x + 3 = 0 using quadratic formula.  

19. Find the nature of roots of x² + 4x + 5 = 0.  
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20. A rectangular garden has area 96 m² and length 4 m more than breadth. Find its dimensions.  

21. Solve: 3x² – 2x – 1 = 0.  

22. Find two consecutive positive integers whose product is 56.  

23. The sum of squares of two consecutive numbers is 313. Find the numbers.  

24. Solve the equation: x² – 11x + 28 = 0.  

25. A train travels 120 km at a certain speed. If the speed is increased by 20 km/h, it takes 1 hour less. 

Find the original speed.  

Application-Based Activity  

Objective: To understand the practical application of mathematical concepts in daily life.  

Instructions: Prepare a chart/project file showing real-life applications of the first four chapters.  

1. Real Numbers: Find examples where HCF and LCM are used in daily life such as traffic signals, school 

timetables, and repeating events.  

2. Polynomials: Observe patterns or designs in floor tiles, rangoli, or art and relate them to algebraic 

expressions.  

3. Pair of Linear Equations in Two Variables: Create one real-life problem involving cost, distance, or 

age comparison. Form and solve the equations.  

4. Quadratic Equations: Identify parabolic shapes in bridges, water fountains, or ball trajectories. Paste 

or draw pictures and explain the mathematical concept.  

  

 
 
 
 

Worksheet - 1 (For Roll No. 1 to 15) 

I. Conceptual Questions 

1. Why does the color of copper sulphate solution change when an iron nail is dipped in it? Write the 

chemical equation involved. 

2. While diluting an acid, why is it recommended that the acid should be added to water and not water to 

the acid? 

3. What would be the consequences of a deficiency of haemoglobin in our bodies? 

4. Why is a convex mirror used as a rear-view mirror in vehicles? Give two reasons. 

5. Why do stars appear to twinkle, while planets do not? 
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II. Numerical Problems 

6. An object 4 cm in height is placed at 25 cm in front of a concave mirror of focal length 15 cm. At what 

distance from the mirror should a screen be placed to obtain a sharp image? Find the nature and size of 

the image. 

7. A person needs a lens of power -5.5 dioptres for correcting his distant vision. What is the focal length 

of the lens? What is the nature of the lens? 

III. Competency based question 

8. A student burns a magnesium ribbon in the air and collects the white ash. She then dissolves this ash in 

water and tests it with red litmus paper. 

          (i) Predict the color change of the litmus paper. 

          (ii) Justify your answer by identifying the nature of the oxide formed. 

9. A patient is diagnosed with an eye defect where the image of a nearby object is formed behind the 

retina. 

(i) Identify the defect. 

(ii) Draw a ray diagram showing the correction of this defect using the appropriate lens. 

IV. Case Study  

1. A student treated a silver chloride powder with sunlight for some time. He observed that the white 

powder turned grey.  

          (i) Name the type of chemical reaction that occurred. 

          (ii)Write the balanced chemical equation for this process. 

         (iii)Mention one use of this reaction in the field of photography. 

V.  Project Work (Use A4 size sheets) 

Create a "pH Scale Chart" using a natural indicator (like red cabbage juice or turmeric). Test five household 

substances (e.g., lemon juice, soda, vinegar, soap solution, and tap water). Paste the color-changing strips 

and record your findings. 

Instructions  

i. Compile all your A4 sheets in a neat and sturdy folder. 

ii Cover Page: Create an attractive and professional Cover Page for your folder. It must clearly display the 

following information: 

Name of the School 

Subject: Science Holiday Homework 



Student’s Name 

Class and Section 

Roll Number 

WORKSHEET- 2 (For Roll No. 16 to 30) 

I. Conceptual Questions 

1. Why should Plaster of Paris be stored in a moisture-proof container? Explain with a chemical equation. 

2. How are the alveoli designed in human beings to maximize the exchange of gases? 

3. Why does the sky appear dark instead of blue to an astronaut in space? 

4. Define the term 'Power of Accommodation' of the human eye. 

5. Why is the refractive index of diamond (2.42) higher than that of ordinary glass? What does this signify 

about the speed of light in a diamond? 

 

II. Numerical Problems 

6. A convex lens forms a real and inverted image of a needle at a distance of 50 cm from it. Where is the 

needle placed if the image is equal to the size of the object? Also, find the power of the lens. 

7. Light enters from air to glass having a refractive index of 1.50. Calculate the speed of light in the glass. 

(Speed of light in vacuum is 3 \times 10^8 m/s). 

III. Competency based question 

8. In a factory, the waste water has a pH of 3.5. 

(i)What will be the impact of this water if it is discharged directly into a nearby river? 

(ii)Suggest a chemical substance that can be used to treat this water before discharge and explain the 

reaction involved. 

9. Why are danger signals and stoplights always red in color? Use the concept of scattering and 

wavelength to explain why other colors like blue or yellow are not used. 

IV. Case study  

During vigorous physical exercise, athletes often experience severe muscle cramps in their legs. 

(i) Which 3-carbon molecule is produced in the muscles during this condition? 

(ii)Why is less energy produced during this process compared to aerobic respiration? 

(iii)How can hot water baths or massage help in relieving these cramps? 



V. Project Work 

Prepare a "Ray Diagram Portfolio." Draw neat and labeled ray diagrams for all six positions of an object in 

front of a concave mirror. Use different colors to represent the incident and reflected rays. 

Instructions  

i. Compile all your A4 sheets in a neat and sturdy folder. 

ii. Cover Page: Create an attractive and professional Cover Page for your folder. It must clearly display the 

following information: 

Name of the School 

Subject: Science Holiday Homework 

Student’s Name 

Class and Section 

Roll Number 

 

 

 

WORKSHEET- 1 (For Roll No. 1 to 15) 

1. Multiple Choice Questions (MCQs) 

i. Which level of government looks after village administration? 

 a) Central Government    b) State Government 

 c) Local Government    d) Supreme Court 

ii. The system of government in Belgium is an example of: 

 a) Dictatorship    b) Federalism 

 c) Monarchy    d) Military Rule 

iii. Which sector converts raw material into finished goods? 

 a) Primary Sector   b) Secondary Sector 

 c) Tertiary Sector   d) Public Sector 

iv. Which of the following is part of the tertiary sector? 

 a) Farming    b) Banking 

 c) Mining     d) Fishing 

v. Who painted “The Dream of Worldwide Democratic and Social Republics”? 

 a) Frederic Sorrieu   b) Bismarck 

 c) Napoleon    d) Mazzini 

SUBJECT – SOCIAL STUDIES 



vi. Giuseppe Mazzini belonged to: 

 a) Germany    b) Italy 

 c) France     d) Greece 

vii. Which event is considered the start of globalization in the modern world? 

 a) Industrial Revolution   b) First World War 

 c) Silk Route Trade   d) French Revolution 

viii. Which institution helps in maintaining global trade rules? 

 a) UNO     b) WTO 

 c) IMF     d) WHO 

ix. In India, subjects like police and agriculture belong to: 

 a) Union List    b) State List 

 c) Concurrent List   d) Residuary List 

x. MNC stands for: 

 a) Multiple National Company  b) Multinational Corporation 

 c) Multi Network Company  d) Market National Corporation 

 

Case Study 1: 

Read the passage carefully and answer the questions: 

India is a federal country where powers are divided between the Central and State governments. The 

Constitution clearly mentions subjects under Union, State, and Concurrent Lists. Local governments were 

strengthened after the Constitutional amendments of 1992. 

Questions: 

1. Name the three levels of government in India. 

2. Which list includes education? 

3. What was the importance of the 1992 Constitutional amendments? 

4. Give one example of a subject in the Union List. 

 
Case Study 2 

Read the passage carefully and answer the questions: 

India’s economy is divided into three main sectors — the Primary Sector, Secondary Sector, and Tertiary 

Sector. The primary sector involves activities related to the extraction and production of natural resources 

such as agriculture, fishing, forestry, and mining. Most people in rural India are engaged in this sector. 

However, despite employing a large portion of the population, the contribution of agriculture to India’s 

GDP has gradually declined over the years. 

The secondary sector includes manufacturing and industrial activities. In this sector, raw materials from the 

primary sector are processed into finished goods. Examples include textile industries, automobile 

manufacturing, and construction work. Industrial growth is considered important for economic 

development because it creates employment opportunities and increases production. 



The tertiary sector, also known as the service sector, provides services rather than goods. It includes 

banking, transport, communication, healthcare, education, tourism, and information technology. In recent 

decades, the service sector has become the largest contributor to India’s GDP due to rapid urbanization, 

technological advancement, and globalization. 

All three sectors are interdependent. For example, farmers need tractors and fertilizers produced by 

industries, while industries and farmers both require transport, banking, and communication services 

provided by the tertiary sector. 

  

1. Multiple Choice Questions (MCQs) 

i. Which sector includes agriculture and fishing? 

 a) Secondary sector     b) Tertiary sector 

 c) Primary sector      d) Industrial sector 

ii. What happens to raw materials in the secondary sector? 

 a) They are exported directly    b) They are processed into finished goods 

 c) They are wasted     d) They are stored permanently 

iii. Which sector is also known as the service sector? 

 a) Primary sector     b) Secondary sector 

 c) Agricultural sector     d) Tertiary sector 

iv. Why has the tertiary sector grown rapidly in India? 

 a) Decline in population     b) Increase in rainfall 

 c) Urbanization and technological advancement d) Reduction in industries 

v. Which of the following is an example of the secondary sector? 

 a) Banking      b) Fishing 

 c) Textile manufacturing     d) Teaching 

  

WORKSHEET- 2 (For Roll No. 16 to 30) 

Multiple Choice Questions (MCQs) 

1. Which country has a “coming together” form of federation? 

 a) India       b) Belgium 

 c) USA       d) Sri Lanka 

2. Panchayati Raj is related to: 

 a) Urban Government    b) Village Government 

 c) Central Government    d) Judiciary 

3. Which sector is the largest employer in India? 

 a) Primary Sector     b) Secondary Sector 

 c) Tertiary Sector     d) IT Sector 

4. Which activity belongs to the primary sector? 

 a) Transport      b) Teaching 

 c) Dairy Farming     d) Banking 



5. Who led the unification of Germany? 

 a) Napoleon      b) Otto von Bismarck 

 c) Mazzini      d) Garibaldi 

6. What was the main aim of conservatives in Europe after 1815? 

 a) Democracy      b) Liberalism 

 c) Restore monarchies    d) End trade 

7. The Silk Route connected: 

 a) Europe and America    b) Asia with Europe and North Africa 

 c) India and Australia     d) China and Japan only 

8. Liberalization means: 

 a) Removal of trade barriers    b) Increase in taxes 

 c) End of industries     d) Ban on imports 

 

9. Which institution conducts elections in villages? 

 a) Parliament      b) Municipal Corporation 

 c) Gram Panchayat     d) Supreme Court 

10. Which sector includes government hospitals and schools? 

 a) Private Sector     b) Public Sector 

 c) Organized Sector     d) Industrial Sector 

 

Case Study -1 

Read the passage carefully and answer the questions: 

The spread of railways, steamships, and telegraphs reduced travel time and connected markets across the 

world. Trade expanded rapidly during the nineteenth century. Multinational companies increased 

investments in many countries. 

Questions: 

1. Name two inventions that improved global connectivity. 

2. What was the effect of faster transport on trade? 

3. What are multinational companies? 

4. Mention one positive effect of globalization. 

 

Case Study -2 

 During the 19th century, the idea of nationalism emerged as a powerful force in Europe. Nationalism 

refers to a sense of shared identity and unity among people who have common language, culture, history, 

and traditions. Before nationalism spread, Europe was divided into many small kingdoms and empires 

ruled by monarchs. 



The played a major role in spreading nationalist ideas. It introduced the concepts of liberty, equality, and 

fraternity. The revolution also emphasized the idea that the nation belonged to its people rather than a 

monarch. As these ideas spread across Europe, people began demanding freedom and self-rule. 

One of the most important figures associated with nationalism in Italy was Giuseppe Mazzini. He believed 

that Italy should be united as one nation instead of being divided into separate states. Secret societies 

were formed to promote nationalist movements. 

Similarly, Germany was unified under the leadership of Otto von Bismarck, who used a policy of “blood and 

iron” involving wars and diplomacy. In many parts of Europe, nationalism inspired people to fight against 

foreign rule and establish independent nation-states. 

However, nationalism also led to conflicts and rivalries among European nations. Intense competition and 

aggressive nationalism later became one of the causes of. 

 

Multiple Choice Questions (MCQs) 

1. What is nationalism? 

 a) Love for monarchy   b) Sense of shared identity among people 

 c) Rule by foreign powers  d) Division of nations 

2. Which event played a major role in spreading nationalism in Europe? 

 a) Industrial Revolution   b) Russian Revolution 

 c) French Revolution   d) American Civil War 

3. Who was associated with the unification of Italy? 

 a) Otto von Bismarck   b) Napoleon Bonaparte 

 c) Giuseppe Mazzini   d) Kaiser William I 

4. What policy did Bismarck use to unify Germany? 

 a) Peace and trade   b) Blood and iron 

 c) Divide and rule    d) Non-violence 

5. Aggressive nationalism became one of the causes of: 

 a) French Revolution   b) Industrial Revolution 

 c) World War I    d) Russian Revolution 

 

                                          ACTIVITY WORK 

Group 1 – Roll No. 1 to 10        Activity: Research Paper 

Topic Options (Any One): 

1. Federalism in India 

2. Consumer Rights 

3. Sustainable Development 

4. Agriculture and Indian Economy 

  



Instructions: Prepare a handwritten research paper of 8–10 pages. 

Include: 

 Introduction 

 Main Content 

 Current Examples 

 Conclusion 

 Pictures/News Clippings 

 Add one map related to the topic. 

  

Group 2 – Roll No. 11 to 20       Activity: Creative Poster Making 

Topics (Any One): 

1. Save Environment 

2. Unity in Diversity 

3. Consumer Awareness 

4. Importance of Democracy 

  

Instructions: 

 Prepare a colourful poster on A3 sheet. 

 Use slogans, drawings, and creative ideas. 

 Poster should reflect social awareness and creativity. 

  

Group 3 – Roll No. 21 to 30      Activity: Informative Chart / Booklet 

Option A – Chart Making 

 

Prepare an informative chart on: 

1. Types of Resources 

2. Sectors of Indian Economy 

3. Fundamental Rights 

4. Water Conservation 

  OR 

Option B – Booklet 

Prepare a small booklet (5–6 pages) on: 

  

1. Disaster Management 

2. Indian Constitution 

3. Globalisation 

4. Public Facilities 

  

Instructions: 

·         Include pictures, diagrams, and important points. 

·         Make the work neat and attractive. 



  

Common Activity for All Groups 
 Newspaper Reading & Weekly Reflection 

 Students must read newspapers regularly during holidays. 

 Write one weekly reflection based on any important national or international news. 

  

Mention: 

1. Date of news 

2. Heading 

3. Summary in 5–6 lines 

4. Your opinion about it 

  

 

  

  

WORKSHEET  

SECTION A -Multiple Choice Questions  

1. Which of the following is an example of verbal communication? 
 a) Sign language    b) Facial expressions 
 c) Telephone conversation  d) Body posture 

2. Which key combination is used to copy selected text? 
 a) Ctrl + X     b) Ctrl + C 
 c) Ctrl + V     d) Ctrl + P 

3. Which of the following is an input device? 
 a) Printer     b) Monitor 
 c) Keyboard    d) Speaker 

4. Which protocol is used for sending emails? 
 a) HTTP     b) FTP 
 c) SMTP     d) TCP 

5. What is the full form of URL? 
 a) Uniform Resource Locator  b) Universal Record Link 
 c) Uniform Record Locator  d) Universal Resource Link 

6. Which option is used to save a document in LibreOffice Writer? 
 a) File → Save    b) Edit → Save 
 c) View → Save    d) Tools → Save 

7. Which of the following is a cyber-safety practice? 
 a) Sharing passwords   b) Using weak passwords 
 c) Installing antivirus software  d) Opening unknown links 

8. A table in a database consists of: 
 a) Slides     b) Rows and Columns 
 c) Images     d) Charts 

9. Which SQL command is used to retrieve data? 
 a) INSERT     b) UPDATE 
 c) SELECT     d) DELETE 

10. Which networking device connects multiple computers in a LAN? 

SUBJECT – INFORMATION TECHNOLOGY 



 a) Scanner     b) Switch 
 c) Microphone    d) Webcam 

Section B – Subjective Questions 

11. Explain any four barriers to effective communication. 
12. Write the steps to create a table in LibreOffice Writer. 
13. What is self-management? Write any three self-management skills. 
14. Differentiate between Internet and WWW. 
15. What is a database? Mention any two advantages. 

Section C – Case Study Based Questions 

Case Study 1 

Riya received an email from an unknown person asking for her bank details and password. She clicked the 
link and shared the information. 

Questions: 

1. Identify the cyber threat in the above case. 
2. What mistake did Riya make? 
3. Suggest two cyber safety measures. 

Case Study 2 

A school computer lab has 20 computers connected together to share files and internet connection. 

Questions: 

1. What type of network is used here? 
2. Name one networking device used in the lab. 
3. Mention one advantage of networking. 

Activity Based Task 

Task 1 – Digital Documentation (For Odd roll no.) 

1. Create a document in LibreOffice Writer on the topic: 
 “Importance of Digital Technology in Education” 

2. Apply the following formatting features: 

 Heading styles 

 Bold, Italic, Underline 

 Bullets and Numbering 

 Page Border 

 Header and Footer 
3. Insert: 

 One table 

 One image 

 Page number 

http://www/


 

Task 2 – Internet and Cyber Safety (For Even roll no.) 

1. Prepare a poster or presentation on: 
 “Cyber Safety and Security” 

2. Include: 

 Strong password tips 

 Safe browsing habits 

 Protection from phishing 

 Importance of antivirus software 
3. Add suitable pictures and slogans. 

 

 

 

Values & Life Skills Assignment 

1. Integrity – “The Project Submission” 

Case Study: 

During their board project work, Meera and her group were short on time. One member suggested copying 

data from an online source without citation, saying “Everyone does it, and the teacher won’t check.” Meera 

disagreed. She argued that submitting copied work would misrepresent their effort and violate academic 

honesty. She proposed splitting the remaining work and working late to finish it authentically. The group 

agreed reluctantly. Their project scored slightly lower, but the teacher praised their originality and 

teamwork. Meera later reflected that compromising on integrity would have damaged her credibility, even if 

it saved time. 

Tick the correct answer: 

1.Why did Meera oppose copying the data? 

a) She wanted to do all the work herself 

b) She was afraid of her parents finding out 

c) She believed it violated academic honesty and misrepresented their effort 

d) She didn’t trust her group members  

2. What argument did the other group member use to justify copying? 

a) The data was incorrect 

b) There wasn’t enough time to read the source 

c) The teacher allowed it last year 

d) “Everyone does it, and the teacher won’t check”  

2.  What was the outcome of Meera’s decision? 

a) The teacher praised their originality despite a slightly lower score 

b) The group failed the project 

SUBJECT – VALUE EDUCATION 



c) The teacher gave them extra time without question 

d) The project was rejected outright  

3.  What does Meera’s reflection highlight about integrity? 

a) Integrity is only important for top scorers 

b) Integrity makes group work harder 

c) Integrity matters only in exams 

d) Integrity protects long-term credibility even when short-term gain is possible 

Short Answer & Reflection: 

1.Write 7-9 sentences: Discuss a situation where choosing integrity had a short-term cost but a long-term 

benefit. What did you learn from it? 

2.Activity: Ethical Dilemma Journal – Record one situation this week where you faced a choice between 

convenience and honesty. Write 3-4 lines on your decision and its consequence.  

2. Discipline – “The Board Exam Countdown” 

Case Study: 

Rohan had 8 weeks until his board exams. He made a detailed study timetable but struggled to follow it 

consistently. He often got distracted by social media and postponed difficult subjects. His mentor advised 

him to use “time blocking” and “accountability checks.” Rohan started studying in 90-minute focused 

blocks, kept his phone in another room, and reviewed his progress with his mentor every Sunday. It was 

uncomfortable at first, but his consistency improved. By the exam, he felt prepared and less anxious. He 

realized discipline wasn’t about being perfect, but about returning to the plan after slipping. 

Tick the correct answer: 

1. What was Rohan’s main challenge with his study plan? 

a) The plan was too easy 

b) He had no subjects to study 

c) He got distracted and postponed difficult subjects 

d) His mentor gave him too much work  

2. What technique did his mentor suggest to improve focus? 

a) Studying longer hours daily 

b) Studying only at night 

c) Forming a larger study group 

d) Time blocking and accountability checks  

3. What change helped Rohan stay on track? 

a) Using focused blocks and regular progress reviews 

b) Reducing his study time 

c) Switching to a new timetable weekly 

d) Asking friends to remind him constantly  

4. What key insight did Rohan gain about discipline? 

a) Discipline means never making mistakes 

b) Discipline only works for motivated people 

c) Discipline replaces the need for planning 

d) Discipline is about returning to the plan after slipping  



Short Answer & Activity: 

1. Write 9 sentences: What are your biggest distractions during study time? Propose one concrete 

strategy to reduce each distraction. 

2. Activity: Discipline Audit – For 5 days, track how you spend 2 hours after school. Categorize time as 

“productive,” “neutral,” or “distraction.” Identify one change to increase productive time.  

Note for Parents: 

Grade 10 students are preparing for high-stakes exams and life decisions. Use these worksheets to discuss 

decision-making, accountability, and self-management. Encourage honest reflection over “correct” answers. 

Students are instructed to complete the Holiday Homework neatly in their Moral Education Notebook and on 

the worksheets provided only.  

 


